Understanding History through Data:
Cholera in Amsterdam, 1866

As you have seen in the map room at the University Library, Cholerakaart (see fig. 1) represented the number
of deaths occurred in each district in 1866 when cholera stroked Amsterdam and caused more than 1000 death
in merely five months. What does this map tell us, the readers in 21% century about this tragic event over a
hundred years ago?

Figure 1 Cholerakaart

PART I: Understanding Cholerakaart

Cholerakaart shows the deaths of each wijk spanning across 20 weeks starting from the first of June, to 18" of
October, 1866. The detailed number of deaths in each week is presented in a color-coded wheel. How to read
these wheels/pie charts? Taking wijk W for example (fig. 2):



Figure 2 Wijk W

According to the legend in the lower right corner of the map (fig. 3) , we see how the colors (and location) of
each slide translated to a particular week. For instance, the light blue slide in the legend indicated week #5,
29-6-1866 to 5-7-1866. Looking at wijk W’s wheel, the light blue slide (week 5) has a number “3” next to it,
meaning there were 3 deaths in wijk W during week 5, between 29" June and 5" July, 1866. The uncolored
slide means no death occurred during that week. The numbers below the wheel shows the population of wijk
W and the total mortality rate (per thousand) during the entire five months.

Figure 3 Cholerakaart legends

Similarly, if we write down all the numbers in wijk W’s wheel in an excel table, it looks like this:

[4]la] B clo|e|Frle|nfi o]kl |m|[Nn | oflPrp|lalr]ls|T|u|vVv] | w x| Y
1 ID Wijk1850 lwkl wk2 wk3 wkd wk5 wké wk7 wk8 wk9 wki10 wkil wki2 wki13 wkild wk15 wk16 wk17 wki8 wk19 wk20|Total |Population Mortality Rate(/1k)
23 22w ] 0 1] 0 3 5 7 9 12 3 4 1 2 1 2 4 ] 1 ] 0 10037 55




In the total cell, you can calculate the total death in W over the twenty weeks:

A B C D E F G H | J K L M N o] P Q R 5 T u v W X
1 ID Wijk1850 jwkl wk2 wk3 wkd wk5 wk6 wk7 wk8 wk9 wk10 wki1l wk12 wk13 wkl4 wk15 wk16 wk17 wk18 wk19 wk20|Total [Population
23| 22w 0 0 0 0O 3 5 7 9 12 3 4 1 2 1 2 4 0 1 0 0] =sum(CZ3:V23)|

PART I1: A data view of Cholerakaart

Task 1: Fill in the data for wijk B-F
1. Open CholerakaartData.xlsx and go to sheet ‘Cholerakaart’

2. Read Cholerakaart and fill the table for wijk B to F (A is filled as an example)

C| D E F G H | J K L M N [0} P Q R 5 T U v W X
wkl wk2 wk3 wk4 wk5 wké wk7 wk8 wk9 wk10 wkil wki12 wki3 wki4 wki15 wki6 wki7 wk18 wkl9 wk20 Population Mortality Rate(/1k) ‘
0 1 0 0 1 Q 0 2 3 1 0 1] 1 1 1 1 1] 1] 0 0 4558 2,5‘
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Task 2: Calculate the total number of death

The total number of deaths in wijk A is a sum of deaths in every week. The following steps show how to
calculate total death for wijk A in Excel:

o Method 1:
= (Click the cell under ‘Total’
= Click the formula line (red box)
=  Type in formula: ‘=sum(C2:V2)’ (meaning this cell shows the value equals the sum
from cell column C, row 2 to column V row 2)
= Hit ‘Enter’, the cell will show the total number of deaths in wijk A
=  What is your number?
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o Method 2:
= (Click the cell under ‘Total’
= Click the formula line (red box)
=  Type in formula: ‘=sum(’
= Click cell C2 and drag your mouse to cell V2
= Hit ‘Enter’, the cell will show the total number of deaths in wijk A
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3. Click cell Y2 and move your mouse to the lower right corner and the mouse arrow turns into a cross:
+
4. Drag down to automatically apply the same formula to other cells
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Task 3: Calculate the total number of death using mortality rate

An alternative way to calculate the total number of deaths in a wijk is to use the population and morality rate.
Morality rate in the Cholerakaart indicates the number of death per thousand people in a wijk. Therefore we
can calculate the total deaths by population and morality rate:

Total death = Total population X per thousand Morality Rate /1000
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= (Click the cell under ‘Total deaths’

=  Type in formula: ‘=X2*Y2/1000’

= Ortype ‘=? and then click cell X2, type “*’, click cell Y2 and type ¢/1000°
= Hit Enter, the cell will show the calculated number of deaths in wijk A

LET OP: the calculated number of deaths may not be an integer, but the number of death has to be an integer
since a person can either be dead or alive. We cannot have a 0.3 person died. Therefore the calculated deaths
(usually with decimals) need to be rounded into integer. In this case of wijk A:

4558 X 2.6

Total deaths inwijk A = BT T 11.85 = 12

We thus say the calculated deaths in wijk A is 12, instead of 11.85.

Question:

Now we have the sum of all deaths in each week or the calculated number using population and morality rate.
Which number do you think is more accurate? Please justify your answer.

Hint: think about where the mortality rate comes from.



Task 4: Calculate the missing morality rate

Figure 4 details for wijk RR and NN

Due to some reasons, wijk RR did not have a morality rate, although the population and ‘death wheel’
available.

Can you calculate the morality rate in Excel for wijk RR?
= Going back to CholerakaartData.xIsx
= Fill in the morality rate cell for row RR (marked in orange)

Task 5: Dealing with missing data

For a map that is over 150 years old, it is not surprising that the map is not in a perfect state. As you can see
from figure 4, some numbers around the color wheel for wijk NN is unreadable. Luckily the population and
morality rate number are intact.

Based on what we have learned from the calculated total deaths from morality rate and population, how would
you deal with this unreadable data?

Task 6: Rank by attributes
We would like to know which wijk had the highest total death number and we want to know the top 5 wijks
that have the highest death rate.

Select the table you want to, go to Home menu, to the right end, click on Sort &Filter, in the stroll down
menu, click Filter:
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Click the arrow on Total column, then in the stroll down menu, click Sort Largest to Smallest:
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The wijks will be ranked in descending order based on the total number of deaths.

an ascending or descending order for any attributes you wish. *
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Comparing the two rankings, we see wijk S has the highest death rate but also ranks high in the absolute
number of deaths while wijk ZZ has a high death rate but the absolute number of death is low.

Any other observations you come across?

! The current rank is without the wijk B-F, after filling in the table, the rank may subject to change



PART Il1: Creating your own Cholerakaart in QGIS

With all the calculation done in Excel, now we move on to QGIS and see if we can visualize the excel table in
space.

Task 1: Install QGIS and introduction

1. Installation:

For Windows users:

Download and run the standalone installer, available here:

http://qqgis.org/en/site/forusers/download.html (QGIS Standalone Installer Version 2.12)

When it gives you the option, you do not need to download the sample datasets, although feel free to and use
them for other tutorials or examples.

Double click your installation package and follow the steps.
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Video guide: https://www.youtube.com/watch?v=Io0NPpcOb-sE

For Mac OS users:

OS 10.7 and Higher: Follow the installation instructions provided here:
http://www.kyngchaos.com/software/qqgis

0S 10.6.8: Try using the latest experimental build for Mac OS 10.6.8 provided here:
http://qgis.dakotacarto.com/ (scroll down to and click on “Nightly for Snow Leopard - Mac OS X 10.6”).
Alternatively, try compiling with HomeBrew (http://brew.sh/), following instructions here:
https://github.com/OSGeo/homebrew-osgeo4mac .

Notes for Mac OS users:

Unlike Windows, QGIS has 4 packages for Mac OS to install. They are numbered in the package your just
downloaded, so please install following the sequence.

Video guide: https://www.youtube.com/watch?v=MnXi5b2pgDo

LET OP: Since QGIS is a third-party software (i.e., not from Apple store), you may need an extra step to
authorize the installation. When you double click on the first package, you will see this window:
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After you click [Open anyways], the new window will have a [Open] button. Click it and do the same for all
four packages. Then follow the instructions to install.
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After successfully install QGIS, you can open it by clicking: ¥

2. The basics of the QGIS user interface:
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The elements identified in the figure above are:
Toolbars

Side Toolbar

Layers List / Browser Panel

Map canvas

Status bar

aogrwbdE

You will use the sections for the next tasks.

In the following sections, Text that [Looks like this] directs you through menus and buttons.



Task 2: Create a new map and load the shapefile

= Open QGIS and create a blank file (default)

= Then go to [Layer] -> [Add Layer] -> [Add Vector Layer]
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In the pop up window, click [Browse] and selecting a shapefile 2us cholerkaart.shp from the list and

clicking [Open] loads it into QGIS.
(You only need to load .shp file, while the other files in the shapefile folder provide supporting information

for .shp file.)

QGIS 2.18.2
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Congratulations! You now have a basic map. Now would be a good time to save your work.

_
e Click on the [Save as] button: “={d
e Save the map under the folder of your choice. Your map will be saved in .qgs format.

Once a shapefile is loaded, you can see the 50 districts of Amsterdam in simple, (random) single-color
polygons. Now you can zoom around it using the map navigation tools (in the red bar area).

Tips: Apart from using the @ #n and 4® wonin | J2 wmen jeons on the toolbar with the mouse, navigating can

also be done with the mouse wheel, spacebar and the arrow keys.
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[Tip] in case you ‘lost’ the map (by zooming out too much or move it out of your sight), you can always click

ﬂ [zoom full] to bring the shape file to your screen.

Task 3: Labeling the wijks

Labels can be added to a map to show any information about an object. Any vector layer can have labels
associated with it. These labels rely on the attribute data of a layer for their content.
Now, go to the lower left side of the window, you will see the layer AMS_Cholerkaart is

= Double click the layer’s name: AMS_Cholerkaart

= Orright click on AMS_Cholerkaart, then click on [Properties]
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This gives you Layer Properties dialogue.

As we see from the map above, the Wijks are shown as simple polygons. We want to see the name of the zone
appears on the map.

In the Layer Properties dialogue:

Click the [Labels] on the left side bar
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In the stroll down menu above, choose [Show labels for this layer]

Z Layer Properties - AMS_Cholerkaart | Labels

en Show labels for this layer
" Rule-based labeling

B e

In the [Label with] menu, stroll down and select [Wijk1850], then click [OK]



® [ ] & Layer Properties - Mortality Rate | Labels

¢ General 20 Show labels for this layer B @ |
R Style Label with  ase Wijk1850 F € h
abe Labels w Text/Bu',, ki
12 wk2 8l
Lorem Ipst 13 wka
12 wkd
o . 12wk
4 Rendering 12 whE
) 12 wk7
- Display Lorem lpsd ;g v
12 wk9
@ Actions
¢ Joins ab i
. ¢ Formatting Font Helvetica €,
sbe Buffer
Diagrams
IR Dieg @ Background | Style B &
' Shadow
{ Metadata v Ul € s € B & I g
3 Placement & b T v
Variables _/ Rendering | Size 13.0000 M=
Poaea) Points B &
Coor | =8
Transparency 0% ~ E'
Type case No change B E'
Help Style + Apply Cancel -

Then each zone in your map will be labeled with its Wijk name.

Task 4: Color-coded the wijks based on the total number of death

= Double click the layer’s name: AMS_Cholerkaart (or right click on AMS_Cholerkaart, then click
on [Properties])
= Click on [Style]
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= Select [Total] (which is the total number of death we calculated in part 1) from [Column] drop-down
menu — the [Column] option defines which attribute will be presented on the map.



= Then in the [Mode] menu, select [Quantile (Equal Count)] (You can also define your own

categories in the [Advanced] options.)
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= Click [OK], you will see the wijks are colored in different colors
= Right click on the layer name, then select [Rename] and change the layer name to ‘Total Death’
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Question: What can you learn from this map?



Task 5: Add a new layer/ Copy a layer

Now we have a map showing the total number of death. We also want to learn how the mortality rate varies
from wijk to wijk.

Instead of creating another map file from scratch, we can simply duplicate the one we just made and change
the display to a different attribute, in this case, the mortality rate.

= Right click on AMS_Cholerkaart (or Total Death, if you renamed it already), then click on

[Dupilcate]
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= Right click on the layer name, then select [Rename] and change the layer name to ‘Mortality Rate’
= Double click the new layer’s name, then click on [Properties]
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Again, in the Layer Properties dialogue, change the [Column] attribute to [Morality], meaning this new layer
will present morality rate in different categories marked by different color. In order to distinguish this new

layer from the old one, you may want to change the color from [Color ramp] menu.

Question: What does your new map look like? Is it very different from the total death map? What can it tell
you?

Task 6: Export a map

Before you export a map or to start to work with the Print Composer, you need to load the QGIS map canvas

and adapt their properties to suit your own convenience. After everything is rendered and symbolized to your

liking, click the Q New Print Composer joon in the toolbar or choose [File]>[New Print Composer]. You will be

prompted to choose a title for the new Composer.

’
/% Composer title M

Create unique print composer title
(title generated if left empty)

Add a map area

Click on the & A% ™" m to01har button in the Print Composer toolbar to add the QGIS map canvas. Now,
drag a rectangle onto the Composer canvas with the left mouse button to add the map.
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You can resize the map item by clicking on the [y selectMove item py ry selecting the element, and dragging one
of the blue handles in the corner of the map. This button also helps to move the map to another place. Select
the item and while holding the left mouse button, move to the new place and release the mouse button.

To move layers within the map element, select the map element, click the [ Moveitm onent joon and move the
layers within the map item frame with the left mouse button.

[Tip] After you have found the right place for an item, you can lock the item position within the Print
Composer canvas. Select the map item and use the toolbar (=1 -oekSelected lems (o the top of this Map Composer
window). A locked item can only be selected using the [Items] tab. Once selected you can use the [Items] tab

to unlock individual items. The £V Aems jeon will unlock all locked composer items. With the map
selected, you can now adapt more properties in the map [Item properties] tab.

Add a legend

To add a map legend, click the & A%V eend joon place the element with the left mouse button on the Print
Composer canvas and drag to position. To customize the appearance in the legend [Item properties] tab on
the right side of the window.

Because we are only showing the morality rate in this map, we use the [minus] button to remove the Total
Death layer.
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It is like adding a text box in a PowerPoint.

= Click on & *™in the sidebar
= Type in: Title of your map, your name and the date into the box on the right
= You can also change the font size by clicking on [Font...] button on the right
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= Select on type for export:

The @ Prit icon allows you to print the layout to a connected printer or a PostScript file, depending on installed printer
drivers.

The % Bxportasimage joon exports the Composer canvas in several image formats, such as PNG, BPM, TIF, JPG,...
The Bxportas SVG jcon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).
The I% Exportas PDF joon saves the defined Print Composer canvas directly as a PDF.

=]
(NOTE: the save Prolect jeon can only save the features of your design in QGIS, but not to export as a map.)
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= Enter the name of you map. You can also select the File of type menu for your desired file type (.jpg,

.png, etc.)
= Click [Save], then in the pop up window you can change other options, the default is usually

preferred. Then click on [Save] to finish export.
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Your final map may look like the following:
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Task 7: Your own question and solution

With all the tools you have learned (labeling the polygons, color-coded the wijks based on the information
you wanted to present and to select certain attributes based on the criteria you are interested.) What
guestion(s) that you are interested? Can you use the tools to answer your own question?



